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The Index contains a list of all Help topics available for the User Guide. For 
information on how to use Help, press F1.



Running the Program
To run the Ecological Genetics program, simply enter data in the 

Parameter Entry Panel.    The preferred method of navigating through the 
entry panel is to use the tab key.    This procedure will ensure that you enter 
data in the order that allows the greatest accuracy of the built in checking 
mechanism.    If you enter a value that is outside of its range, a message box 
will appear with information about the range.    Because the ranges of many 
of the values depend on the other values already entered, these ranges will 
be different with each type of analysis.

Because it is possible to enter data out of order and bypass the built-in 
validation routines for each parameter, a second method is employed to 
prevent the use of meaningless data.    When ever your choice of values 
results in one of the breeding parameters being less than zero or greater 
than one, the run button will be disabled.    The present value of the breeding
parameters are displayed on the right side of the button bar.    If you find that
you have been able to enter values without receiving a validation error, but 
you cannot run the program, you should follow these general guidelines:

If Phi(m) is out of range, then check b and var(b), but p also has a big 
influence.

If Phi(w) is out of range, then it is almost always because p and var(p) 
are invalid.

If Phi(f) is out of range, then check var(k).    Also, k may be to large 
(remember, a 

value of 4 represents a doubling of population size every 
generation!).

If you think you know which parameter is the most likely offending 
value, 
simply double-click on it, then press the tab key.    If the value is outside
its limits, the internal validation routines will inform you of the proper values.

When you have every thing you want set like you want it, then the run 
button
should be enabled (you will see a green check mark).    Just click on it and 
the results will be displayed in the Results Pane to the right. 



Window Layout

The Ecological Genetics program has a multiple document interface (MDI) 
that allows the user to open several different analysis windows.    The main 
application workspace consists of a menu and a "client" area.    The client 
area is where the analysis window(s) and charts are displayed.    An analysis 
window consists of a tool bar, parameter entry panel and a results pane.

Because the Ecological Genetics program is an MDI application, you can 
open multiple analysis and chart windows in the client area.    This is useful if 
you would like to compare results from different analyses.



Edit Menu

The Edit menu includes commands that enable you to move text in the 
results pane to and from the clipboard, to delete text, and change the 
appearance of the text.

For more information, select the Edit menu command name.

Cut Deletes text and moves it to the clipboard.
Copy Copies text to the clipboard.
Paste Moves text from the clipboard to the edit window.
Select All Cancels a previous operation.
Font Changes the Font



File Menu

The File menu includes commands that enable you to open and save files, 
establish a new workspace, and to print.

For more information, select the File menu command name.

New
Open
Close
Save
Save As 
Print
Print Setup
Exit



Chart Menu

The Chart menu contains commands for the display of graphs of the results.

For more information, select the chart menu command name.

Gene Correlations
Fixation Indices
Effective Sizes



Chart Gene Correlations Command

This command allows the user to plot the three gene correlations as a 
function of generations.    A discussion of gene correlations is provided in the 
Study Guide.    See Chart Buttons for help on how to manipulate charts.



Chart Fixation Indices Command

This command allows the user to plot the three fixation indices as a function 
of generations.    A discussion of fixation indices is provided in the Study 
Guide.    See Chart Buttons for help on how to manipulate charts.



Chart Effective Sizes Command

This command allows the user to plot the three effective sizes as a function 
of generations.    A discussion of effective sizes is provided in the Study 
Guide.    See Chart Buttons for help on how to manipulate charts.



Window Menu

The Window menu allows you to arrange open documents and icons in the 
workspace.    

For more information, select the Window menu command name.

Cascade
Tile
Arrange Icons
Minimize All



Help Menu

The Help Menu allows you to obtain help on using the Ecological Genetics 
program.

For more information, select the Help menu command name.

User Guide
Study Guide
Charts
About



Tool Bar

The tool bar provides buttons that have the same functionality as many of 
the menu items.    The tool bar is located above the Parameter Entry panel.    
The buttons are

Open a file
Save a file
Print results
Printer setup
Cut text
Copy text
Paste text
Change the font
Chart all results
Exit

In addition to the buttons, the tool bar contains three display areas.    These 
display areas provide the estimates of the breeding parameters, which are 
calculated every time a change is made in the Parameter entry panel.    The 
breeding parameters are probabilities of different types of matings, and their
meanings are discussed in the Study Guide.    Because these parameters are 
probabilities, their values must be between zero and one.    If you make a 
change in the parameter entry panel that results in one of the breeding 
parameters being outside this range, the Run button will be disabled.



Chart Buttons

The Chart tool bar provides buttons that allow the user to change the 
appearance of, save, and print the charts.    The tool bar is located above the 
Chart.    The function of the buttons are

Open a file
Save a file
Copy Bitmap
Copy Data
Print Chart
Change Legend
Vertical Grid
Horizontal Grid
Edit Titles
Change Font
Chart Tools
Chart Options

You can see a description of the function of each tool bar button by pressing 
the right mouse button while the cursor is over the button.



Status Bar

The status bar is found at the bottom of the main window.    This bar provides
information about the various components of the window when the mouse 
cursor passes over them.    This feature is particularly useful when entering 
data in the parameter panel, because it provides a brief explanation of each 
parameter.



Glossary

clipboard
Effective Size
Fixation Index
Gene Correlation
Ideal Population



Copying Text

Choosing this command copies text from the Results pane to the clipboard.    
After the text is placed in the clipboard, it can be pasted back into the 
window or into another application.

A keyboard shortcut for this command is highlight the text, hold down the 
Ctrl key, and press Insert.



Pasting Text

Choose this command to paste text that was previously copied to the 
clipboard into the Results pane.

A keyboard shortcut for this command is highlight the text, hold down the 
Shift key, and press Insert.



Deleting Text

To delete text, simply highlight the text and press either the Delete or 
Backspace key.

Text that has been deleted is not available for pasting because it is not 
copied to the clipboard.    To make the text available for pasting into another 
document, it must be deleted using the cut command.



Cutting Text

Cutting text removes it from the Results Pane and places it in the clipboard.    
To cut text, simply highlight the text and press choose the cut command from
the edit menu.    Text that has been cut is available for pasting.    

A keyboard shortcut for this command is to highlight the text, hold down the 
Shift key, and press Delete.



Exiting

Choose this command to exit the Ecological Genetics program.    If you 
have open window that have changed, or if you have performed calculations 
with the Run button, you will be reminded that these have not been saved.



Edit Copy Command

Choosing this command copies text from the Results pane to the clipboard.    
After the text is placed in the clipboard, it can be pasted back into the 
window or into another application.

A keyboard shortcut for this command is highlight the text, hold down the 
Ctrl key, and press Insert.



Edit Cut Command

Cutting text removes it from the Results Pane and places it in the clipboard.    
To cut text, simply highlight the text and choose the cut command from the 
edit menu.

Text that has been cut is available for pasting.

A keyboard shortcut for this command is highlight the text, hold down the 
Shift key, and press Delete.



Edit Paste Command

Choose this command to paste text that was copied to the clipboard into the 
Results pane.

A keyboard shortcut for this command is highlight the text, hold down the 
Shift key, and press Insert.



Edit Select All Command

This command allows you to select all the text in the Results pane.    This 
command is useful using the clipboard to transfer data to a spreadsheet for 
further analysis.



Edit Font Command

This command allows the user to change the font in the Results pane.    
Changing the font affects all the text in the Results pane, not just the 
highlighted text.



File Exit Command

Choose this command to exit the Ecological Genetics program.    If you 
have open window that have changed, or if you have performed calculations 
with the Run button, you will be reminded that these have not been saved.



File New Command

This command allows you to open a new analysis window.    Each analysis 
window in Ecological Genetics consists of two parts: the Parameter Entry 
panel and the Results pane.



File Open Command

This command allows you to open an existing file.    A dialog box will open to 
allow you to enter the file name or find the file on a disk drive.    There are 
four types of files that you can open and in the Ecological Genetics 
program.    These are:

Tables (*.TAB) - The data in the Results pane.
Base Values (*.BAS) - The values entered in the Parameter Entry panel.
All Values (*.ECO) - Both parameters and results.
Charts (*.CHF) - Charts of the results



File Print Command

This command allows you to print the data in the Results pane.    This 
command will not print the parameters in the Parameter Entry panel or the 
charts.    There are separate commands of opening, saving, and printing 
charts.



File Print Setup Command

This command allows you to change the setup of the currently selected 
printer, or choose another printer.



File Save Command

This command allows you to save the information in the active window.    The
file is saved in ASCII text format.    This command uses the name of the file 
associated with the active window.    If this is a new file, you will be asked to 
provide a file name just as with the Save As command.

There are three types of files that can be saved with the Ecological 
Genetics program.    These are:

Tables (*.TAB) - The data in the Results pane.
Base Values (*.BAS) - The values entered in the Parameter Entry panel.
All Values (*.ECO) - Both parameters and results.

You may use any extension you like for saving all values because the 
program assume that if you are opening a file that doesn't have 
the .TAB, .BAS, or .CHF extensions, you are opening a file that contains both 
parameters and results.    To save a chart, use the save button in the chart 
window.



File Save As Command

This command allows you to save the active window with a different name 
that it was opened with.    It is also the command that is invoked if you 
choose Save for a file that has no file name associated with it.



File Close Command

This command allows the user to close the active window.    If the results 
have changed or this is a new analysis window you will be prompted to save 
the file.



Parameter Entry Panel

Each analysis window in the Ecological Genetics program contains a panel 
where you enter the parameters for the analysis.    When you open a new 
analysis window, the portion of the panel dealing with equilibrium 
populations will be visible.    Each of the edit fields corresponding to a 
parameter will contain a default number.    You may change these numbers 
by double-clicking on the field and entering a new number.    When you click 
on another field, or choose one of the buttons, the number will be checked to
see if it is within the acceptable range of values.    If an invalid number was 
entered, you will prompted to re-enter the number.    A description of the 
parameters is provided in the Study Guide.

In addition to the basic values, the parameter entry form has two check 
boxes that provide for additional behaviors of the model.    The additional 
behaviors are for the incorporation of cyclic and stochastic population 
dynamics.    Clicking on either of these check boxes will reveal an edit field 
for the time to carry out calculations and additional fields for necessary 
information.    Both types of population dynamics can be employed at the 
same time.

Choosing either cyclic and/or stochastic population dynamics requires the 
entry of additional information.    The default values are those for an 
equilibrium population.    A description of the parameters, and their 
acceptable values, is given in the Study Guide.    The check boxes 
corresponding to the basic parameters are used to determine which 
parameters will vary in the desired manner.

There are three buttons on the parameter entry panel.    The Run button will 
perform the calculations and display the data in the Results pane.    The 
Reset button will change all the parameters back to their default values and 
clear the results.    The Help button will bring up the User's Guide (i.e. this 
help session).



Results Pane

The results pane is not visible when you open a new analysis window.    When
you choose the Run button, the necessary calculations will be performed and
the results displayed in tabulated form.    You can copy this data to the 
clipboard for use in other applications that accept tab-delimited, ASCII text 
data.

The results consists of 10 columns.    The first column is for the generation.    
The next three columns give the gene correlations (within individuals, within 
groups, and between groups).    The next three columns are the fixation 
indices (individuals to group, individuals to total, and groups to total).    The 
last three columns are for the effective population sizes (inbreeding, 
coancestral, and intergroup).    A discussion of these values is provided in the 
Study Guide.



Charts Commands

There are three charts available in the Ecological Genetics program.    
These correspond to the gene correlations, fixation indices, and effective 
population sizes.    You can views the charts by choosing the chart type from 
the Chart Menu, or by choosing the Chart All button  on the tool bar.    The 
Chart All button and the Chart Menu items are not available until there are 
results in the Results pane.

The charts rely upon the analysis window for their data, but once they are 
created they behave independently.    Closing an analysis window will not 
close the charts generated from it.    Additionally, printing, saving, and 
copying charts is done by using the tool bar associated with the chart 
window.    To obtain the function of each button, simply press the right mouse
button while the cursor is over the button.    A popup dialog caption will tell 
you what the button does.



Window Cascade Command

Choose this command to arrange the windows such that the active window is
on top and the title bar of all the other open windows are visible.

This command is useful when you have several windows open and you need 
to switch among them frequently.



Window Tile Command

Choose this command to arrange the windows as panels with part of each 
visible.

This command is most useful when comparing the contents of a few 
windows.



Window Arrange Icons Command

Choose this command to arrange all icons of minimized windows so that they
are in a neat row at the bottom of the workspace.

This command is most useful when several windows have been minimize and
then moved by the user.    After issuing the command, the icons should be 
located in a manner that will allow the user to easily find windows of interest 
by their file names.



Window Minimize All Command

Choose this command to minimize all the open windows.    The windows will 
be displayed as icons at the bottom of the client area.

This command is most useful as a means to rapidly clear the work area 
before starting a new project.



Help User's Guide Command

Choose this command to bring up the help system for the Ecological 
Genetics program.    

This system contains an index of topics about the general use of the 
Ecological Genetics program.    It also allows you to search for key words.

The help topics in this system are for general use of the Ecological 
Genetics program (such as editing, opening windows, and running the 
program).    The detailed aspects of the analysis of gene dynamics are 
provided in the Study Guide.



Help Study Guide Command

Choose this command to bring up the On-line Study Guide for the detailed 
description of what the Ecological Genetics program does and the theory 
behind it.    

The help topics in this system are for specifics of the Ecological Genetics 
program.    It provides detailed descriptions of how the various estimates are 
produced.    It also provides some background on how the models were 
developed.    There is also citations for relevant publications, useful 
equations, and example figures provided.    If you would like to go to the 
study guide now, just click here

The general aspects of using the Ecological Genetics program are provided
in the Index.

See also:

User's Guide



Help About Command

Choose this command to obtain general information about the Ecological 
Genetics program.    This information includes the program name, the 
version number, the developers name, and the copyright date.



Edit Window

The edit window in this application allows you to create, open, save, and edit
text file.    All of the output for the Ecological Genetics program is in ASCII 
text format.    To view the results of you analysis, you must use an edit 
window.



Order Form
This product is the shareware version of Ecological Genetics .    You may 
use this version for 21 days for the purpose of evaluation, and you may 
distribute it to others for the same purpose, as long as you do so free of 
charge.    After the evaluation period, you should either discontinue using the 
application, or register your copy.    Registration entitles you to a free copy of 
the latest version of this program, and a serial number.    For more 
information about the registered version, see the license agreement.

Payments must be in US dollars drawn on a US bank, or they may be made 
by international postal money orders in US dollars.    Send the payment and 
this order form to:

Wye Software
19 Vista Dr.
Little Rock, AR 72210-1714

You print this form by choosing Print from the file menu above (Windows 3.1),
pressing the print button on the help toolbar (Windows 95), or clicking here.

An alternate form of ordering is to use the Compuserve Software Registration
Service.    This service will charge your CIS account for the registration fee.    
To use this service enter GO SWREG and follow the menus.    The SWREG 
number for this product is 9561.    You may also register the software by 
phone if you wish to pay be credit card

Ecological Genetics Registration Form
Name: ________________________________________
Company: ________________________________________
Street Address: ________________________________________

________________________________________
City, State, Zip: ________________________________________

Single Copy           $25.00
Additionally copies with this order

________copies @ $12.50 ________
Shipping ________

________copies @ $5.00 ________
Total Payment ________

email address: ________________________________________

Note:    Although every attempt is made to ensure our software will run on 
most machines, we do not have the resources to deal with installation 
problems.    If you have problems installing this software, you probably have 
some hardware incompatibilities.    If this is the case, DO NOT register the 
software.



Credit Card Orders

--------------------------------CREDIT CARD ORDERS ONLY-------------------------------

You can order with MC, Visa, Amex or Discover from Public(software)Library 
at

P.O. Box 35705
Houston, TX 77235-5705
Tel: 800-242-4775
Fax: 713-524-6398

Be sure to specify the program name (ECOGENE) and the program number 
(14471)

THE AUTHOR OF THE PROGRAM CAN'T BE REACHED AT THESE NUMBERS

---------------------------------------------------------------------------------------------------------



License Agreement

When you register your copy of Ecological Genetics you receive a license 
to the latest version of this product for each copy you purchase.    This license
allows you to install the program on as many computers as you would like, 
however, it is your responsibility to ensure that a single licensed copy cannot
be used on more than one computer at any given time.    Additionally, 
licensing the software gives you access to Wye Software's email technical 
support.    Licensing the software does not entitle you to distribute the 
release version to other people, however you may still feel free to distribute 
the shareware version.

THIS APPLICATION IS PRESENTED AS IS AND WITHOUT WARRANTY, EXPLICIT OR IMPLIED.



Credits

Ecological Genetics was developed using Turbo Pascal and Delphi, both 
products of Borland International.    The application contains two 
redistributable files that come with Delphi (b1vbx11.dll & chart2fx.vbx), and 
you may redistribute these only with the shareware version of the program, 
provided you do so free of charge and you include all of the files that came 
with your shareware version.    You may not redistribute the files 
associated with the release version!

Testing of the original version of this program was conducted by Drs. Ronald 
K. Chesser (Dept. of Genetics, Univ. of Georgia), F. Steve Dobson (Dept. of 
Wildlife and Zoology, Auburn Univ.), Edward J. Heske (Division of Wildlife 
Ecology, Illinois Natural History Survey), Robert S. Sikes (Dept. of Evolution, 
Ecology, and Ethology, Univ. of Minnesota), and Merrit N. Sugg (Dept. of 
Mathematics and Statistics, Univ. of Arkansas at Little Rock).    Thanks are 
extended to these people and all the other beta testers.



About Wye Software

Thank you for trying our software.    Wye Software is a small software 
development company devoted to producing teaching and analysis tools for 
biology and mathematics.    It is hoped that the software will be useful to 
students as well as researchers, but the emphasis is placed on education in 
advanced topics.    We appreciate any comments or suggestions about how to
improve or extend these programs, as well as other ideas.    You may contact 
Wye software by email or "snail" mail at the addresses below:

Mathematical Software
Compuserve: 74471.2337
Microsoft Net: GO wyesoft
Internet: 74471.2337@compuserve.com

merrit_s@msn.com

Biological Software
Microsoft Net: IslandFun@msn.com
Internet: Islands@sunbelt.net

U.S. Mail
Wye Software
19 Vista Drive
Little Rock, AR 72210

In the near future (c.a. 2/15/96) we will have a World Wide Web page at:
http://www.augusta.net/dsugg/wyesoft.htm.    

This page will have up-to-date information about our shareware products and
links to other products.    Additionally, it will have links for sending email 
messages to the authors.

Ombudsman

This program is produced by a member of the Association of Shareware 
Professionals (ASP).    ASP wants to make sure the shareware principle works 
for you.    If you are unable to resolve a shareware-related problem with an 
ASP member by contacting the member directly, ASP may be able to help.    
The ASP Ombudsman can help you resolve a dispute or problem with an ASP 
member, but does not provide technical support for members' products.    
Please write to the ASP Ombudsman at 545 Grover Road, Muskegon, MI 
49442-9427 USA, FAX 616-788-2765 or send a Compuserve message via 
Compuserve Mail to ASP Ombudsman:70007.3536@compuserve.com





Windows Keys

The keyboard topics below come from Help for Windows. You can create similar keyboard 
topics for your application's Help. Choose from the following list to review the keys used in 
Windows:
Cursor Movement Keys
Dialog Box Keys
Editing Keys
Menu Keys
System Keys
Text Selection Keys
Window Keys



Cursor Movement Keys

Key(s) Function

DIRECTION key Moves the cursor left, right, up, or down in a field.
End or Ctrl+Right Arrow Moves to the end of a field.
Home or CTRL+Left Arrow Moves to the beginning of a field.
PAGE UP or PAGE DOWN Moves up or down in a field, one screen at a time.



Dialog Box Keys

Key(s) Function

TAB Moves from field to field (left to right and top to bottom).
SHIFT+TAB Moves from field to field in reverse order.
ALT+letter Moves to the option or group whose underlined letter matches 

the one you type.
ENTER Executes a command button.

Or, chooses the selected item in a list box and executes the 
command.

ESC Closes a dialog box without completing the command. (Same as
Cancel)

ALT+DOWN ARROW Opens a drop-down list box.
ALT+UP or DOWN ARROW Selects item in a drop-down list box.
SPACEBAR Cancels a selection in a list box.

Selects or clears a check box.
SHIFT+ DIRECTION key Extends selection in a text box.
SHIFT+ HOME Extends selection to first character in a text box.
SHIFT+ END Extends selection to last character in a text box



Editing Keys

Key(s) Function

Backspace Deletes the character to the left of the cursor.
Or, deletes selected text.

Delete Deletes the character to the right of the cursor.
Or, deletes selected text.



Menu Keys

Key(s) Function

Alt Selects the first menu on the menu bar.
Letter key Chooses the menu, or menu item, whose underlined letter 

matches the one you type.
Alt+letter key Pulls down the menu whose underlined letter matches the one 

you type.
LEFT or RIGHT ARROW Moves among menus.
UP or DOWN ARROW Moves among menu items.
Enter Chooses the selected menu item.



System Keys

The following keys can be used from any window, regardless of the application you are 
using.

Key(s) Function

Ctrl+Esc Switches to the Task List.
Alt+Esc Switches to the next application window or minimized icon, 

including full-screen programs.
Alt+TAB Switches to the next application window, restoring applications 

that are running as icons.
Alt+PrtSc Copies the entire screen to Clipboard.
Ctrl+F4 Closes the active window.



Text Selection Keys

Key(s) Function

SHIFT+LEFT or RIGHT ARROW Selects text one character at a time to the left 
or right.

SHIFT+DOWN or UP Selects one line of text up or down.
SHIFT+END Selects text to the end of the line.
SHIFT+HOME Selects text to the beginning of the line.
SHIFT+PAGE DOWN Selects text down one window.

Or, cancels the selection if the next window is 
already selected.

SHIFT+PAGE UP Selects text up one window.
Or, cancels the selection if the previous 
window is already selected.

CTRL+SHIFT+LEFT or RIGHT ARROW Selects text to the next or previous word.
CTRL+SHIFT+UP or DOWN ARROW Selects text to the beginning (UP ARROW) or 

end (DOWN ARROW) of the paragraph.
CTRL+SHIFT+END Selects text to the end of the document.
CTRL+SHIFT+HOME Selects text to the beginning of the document.



Window Keys

Key(s) Function

ALT+SPACEBAR Opens the Control menu for an application window.
ALT+Hyphen Opens the Control menu for a document window.
Alt+F4 Closes a window.
Alt+Esc Switches to the next application window or minimized icon, 

including full-screen programs.
Alt+TAB Switches to the next application window, restoring applications 

that are running as icons.
Alt+ENTER Switches a non-Windows application between running in a 

window and running full screen.
DIRECTION key Moves a window when you have chosen Move from the Control 

menu.
Or, changes the size of a window when you have chosen Size 
from the Control menu.





Clipboard
The Windows® clipboard is a temporary repository of information that has 
been copied or cut.    This information is available for pasting in other 
Windows® application, provided they understand the format of the 
information.

The Gene Dynamics program used ASCII text format.    This format is 
recognized by most other Windows® applications.



Effective Size
Effective population size if often termed the size of an ideal population that 
loses genetic variation at the same rate as the population under study.    

Effective population sizes are actually a measure of the rate at which a 
population loses genetic variation, and they should not necessarily be 
described in terms of real individuals.

For example, if a population is gaining genetic variation, instead of losing it, 
the effective population size will be negative.

The Gene Dynamics program calculates effective population sizes from the 
rate of change in the gene correlations.    The gene correlations can be 
calculated at any hierarchical level of population structure.    This program 
only deals with the levels of individuals, breeding groups, and subpopulations
or colonies, and an effective size if calculated for each.

More information on the theory of effective population sizes and the methods
used in this program are given in the Study Guide.



Fixation Indices

The fixation indices partition the variation in a population into various 
components that tell a researcher about levels of inbreeding and 
differentiation. 

The Gene Dynamics program calculates three fixation indices.    The first is 
the level of inbreeding relative to members of the breeding groups.    The 
second is inbreeding relative to members of the entire subpopulation or 
colony.    The final index is for the differentiation of breeding groups within 
the subpopulation or colony.

The fixation indices are calculated from the gene correlations.

More information on the theory of inbreeding, differentiation and the 
methods used in this program are given in the Study Guide.



Gene Correlations

Gene correlations are a measure of genetic variation.    As an individual 
becomes more and more inbred, its genes become more correlated in the 
sense they are more likely to have come from the same common ancestor.    
This is also true for the correlation of genes between different individuals in 
the same breeding group and subpopulations or colonies if they share 
common ancestors.    The more correlated the genes, the less genetic 
variation there is.

The Gene Dynamics program calculates the gene correlations within 
individuals, between different individuals from the same breeding group, and
between different individuals from different breeding groups.

The gene correlations are used to calculate the fixation indices and effective 
population sizes.

More information on the theory of gene correlations, genetic variance, and 
the methods used in this program are given in the Study Guide.



Ideal Population

An ideal population is a theoretical construct that population geneticists use 
to understand how, and the rate at which, natural populations lose genetic 
variation.

An ideal population is one that consists of dioecious, diploid, randomly 
mating individuals with equal numbers of each sex.    Furthermore, the 
population can not be under selection, there can be no immigration or 
emigration, and mutation is absent.

Ideal populations lose genetic variation because they are of finite size.    The 
random loss of genes (genetic drift) and chance matings of related 
individuals (inbreeding) are all a function of the size of the population.

Obviously, no natural populations meet all of the conditions of an ideal 
population.    They may lose genetic variation more or less rapidly than an 
ideal population of the same size.

The effective population size of a natural population is often said to be the 
size of an ideal population that loses genetic variation at the same rate as 
the study population.    There are some problems with this interpretation that 
are discussed in the Study Guide.

The Gene Dynamics program calculates the lose of genetic variation and 
from this can determine the effective population size.

More information on the theory of population genetics and the methods used
in this program are given in the Study Guide.



 




